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Summary 
 
The content of this PERFORM Operating Document (POD) provides for the safe use and 
cleaning of the Cosmed K4 b2 portable metabolic system as identified as equipment 
inventory at the PERFORM Centre, Concordia University. 
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1. Definition of Terms  

PERFORM operating 
document (POD) 

Operating documents that are specific to an 
instrument or technique that require approval by area 
managers.  

Standard Operating 
Procedure (SOP) 

SOP’s at PERFORM are any operating document that 
require a full review process and approval by the SD. 

Supervisor 

Knowledgeable person regarding all or an aspect of a 
project or program and is familiar with PERFORM's 
best practices, that is responsible for ensuring that 
users conduct their activities in a safe manner and 
within scope of the project. 

User Person using space or equipment at the PERFORM 
Centre that has received adequate technical and safety 
training. 

 

2. Relevant Documents 
 
This POD is governed by the following Concordia University policies, SOPs, and PODs: 
 

• PC-SOP-GA-007 “General Access to PERFORM Centre”.  
• PC-SOP-GA-009 “Emergency Response Procedures at the PERFORM Centre”. 
• PC-SOP-GA-011 “Guidelines for Management of Incidental Findings at PERFORM”. 
• PC-SOP-GA-005 “Professional Supervision of Physical Activity and Exercise Testing at the 

PERFORM Centre”. 
• PC-POD-GA-001 “PERFORM Centre Booking System for Facilities and Equipment”. 
• PC-POD-CF-001 “Clearance for Physical Activity at PERFORM”. 
• PC-POD-CP-002 “Use and Cleaning Procedures for Manual and Automatic Aneroid 

Sphygmomanometers”. 
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3. Introduction 

3.1 Background 

The Cosmed K4 b2 is a portable electrical medical device designed to perform 
pulmonary function tests and record breath-by-breath data for the purpose of exercise 
testing, which can be performed underwater. The data one may acquire from this 
reliable and valid portable system is oxygen consumption (VO2), carbon dioxide 
excretion (VCO2), energy expenditure, among others.  

3.2 Purpose 

The objectives of the current POD are to 1) outline the procedure of using the Cosmed 
K4 b2 portable metabolic system; 2) provide a set of standard practices for the safe 
operation of the Cosmed K4 b2; and 3) outline the procedure of cleaning/disinfecting at 
the PERFORM Centre, Concordia University. 

3.3 Scope 

This POD applies to all users and supervisors using the Cosmed K4 b2 portable metabolic 
system at the PERFORM Centre, Concordia University. Any other document other than 
this POD is out of scope for this operating procedure. 

3.4 Responsibility 

It is the responsibility of all users and supervisors to ensure that this POD is followed. 
 
 

4. Main Components 

4.1 K4 b2 Portable Unit - contains the O2 and CO2 analyzers, sampling pump, UHF 
transmitter, barometric sensors and electronics. The portable unit shows in real time the 
following parameters: tidal volume (VT), minute ventilation (VE), VO2, VCO2, respiratory 
quotient (R), heart rate (HR), respiratory frequency (RF), battery charge level, temperature, and 
barometric pressure. 
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4.2 K4 b2 Receiver Unit - consists of a small unit connected to a PC through the RS 
232 serial port. It houses a miniaturized transmitter module, which is responsible for the 
transmission.  

 
 
 

4.3 Battery Charger - allows the simultaneously charge of the 3 Ni-Cd batteries and 
to supply the portable unit during the warm up time.  
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4.4 Battery – The battery powers the portable unit for approximately 3 hours. 

 
 

4.5 The HR Probe – The HR probe consists of two parts: the HR transmitter (belt) 
and receiver. Both parts should be assembled as close as possible to one another to 
acquire the most effective communication signal. 

 
 

4.6 Harness – The harness, worn by the participant, is a holder for the portable unit 
and other accessories during the test.  
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4.7 ID28 Flowmeter (a.k.a. turbine) – consists of a bidirectional turbine and an 
optoelectronic reader. The reader measures a wide flow range of infrared light 
interruptions caused by the spinning blade inside the turbine. The ID28 can be used for 
all tests except for RMR testing.  

 
 

NOTE: The ID18 flowmeter is used for RMR testing and is provided with the canopy 
option only, which is not included with the system at the PERFORM Centre, Concordia 
University. 
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4.8 Gas Cylinder – The gas cylinder is composed of 16% O2, 5% CO2, and remaining 
balance of N2 and is used to calibrate the system.  

 

 

 
 
 
 
 
 
 
 
 
 

Secondary leak valve 

Primary leak valve 

Knob to adjust kpa 

Main valve 
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4.9 Calibration Unit – The calibration unit, connected between the gas cylinder and 
the unit, is the tool for its calibration, according to the procedure shown below. 

 
 

4.10 GPS – The GPS unit detects the participant’s path, stores it and allows its 
graphing after the test. 

 
 

4.11 K4 b2 Software - software used to capture exercise-testing data.  
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4.12 Smaller Components  

 
1. Head cap 
2. Mask 
3. Flowmeter/Turbine 
4. Optoelectronic reader 
5. Wind cover 
6. Sampling line 

 
4.13 ECG Option – 12-lead ECG used to capture electrical activity of the heart. 
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4.14 Aquatrainer (underwater feature) Option – provides similar breath-by-
breath data, only underwater. 
4.14.1 Snorkel and Tube – For the convenience of the participant, this is 

one of the last pieces of equipment to be set up. 

 
 

4.14.2 Harness and Rod – Worn by the operator, harness and rod allow 
Aquatrainer case to be suspended in the air while participant swims. 
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4.14.3 Polar Heart Rate Transmitter – Transmits heart rate signal to 
computer. 

 
 

4.14.4 Noseclip – Crucial to ensure that participant is breathing through the 
mouthpiece. 
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4.14.5 Aquatrainer Case – Attaches onto rod and contains portable unit and 
battery.  

 

 
 

5. Installation 
 

5.1 Installation of battery charger 
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Legend 
1. On-Off switch  
2. Main plug 
3. Portable unit power supply plug 
4. Voltage switch 
5. Plug for car charging adapter 
6. Charger unit 
7. Battery 
8. Led charging indicator 
9. Black charging cable  

 
5.1.1 Plug the black charging cable (9) into the main plug (2) and turn on the 

battery charger unit by pressing the green On-Off switch (1) to ON. 
5.1.2 Place the batteries (7) on the top of the charger unit (6) as shown above. 

When the green LED lights at the front (8) turn on, this means that the 
batteries are charging. 

5.1.3 When the LED lights at the front (8) begin to flash, this indicates that the 
batteries have been fully charged. 

NOTE: It is recommended to charge batteries before each test. When the batteries are 
low, the Portable Unit will deliver two beeps as a warning for a half charged battery and 
three beeps for a completely empty battery. One must then change said batteries 
immediately. The system allows changing the battery during testing as well.  
 
NOTE: During the test, it is possible to monitor the battery status in real time by 
selecting “Information” from the “View” menu. 
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5.2 Installation of portable unit  

 

 
 

 

Legend 
A. Marker key  
B. Display 
C. Cancel key 
D. Enter key 
E. Scroll up/down key 
F. On/Off key 
1. Antenna 
2. Sampling 
3. 6V power cable 
4. Turbine 
5. Temperature and HR probe 
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5.2.1 Connect the 6V power-supply cable to the Charger Unit and K4 b2 and 
turn on charger unit.   

 
 

5.2.2 Turn the K4 b2 on by pressing the on/off key (F).  

 

5.3 Warming-Up Cosmed K4 b2 

5.3.1 System warm-up needs to be completed before calibrating the system 
and before any tests are performed. The following table displays the 
warm-up time required for each test: 

 
 
NOTE: During the warm-up period, the device must be powered on, but the 
software does not need to be open. 
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6. Calibration  
NOTE: Calibration should not be performed until the system has completed the 
required warm-up period.  

NOTE: Prior to calibrating, cellular phones should be turned off to eliminate potential 
electrical interferences. 

 

6.1 Setting Reference Values 

6.1.1 OPTION 1: Set reference values using the PC software. 
NOTE: It is only necessary to configure these values the first time the device is used or if 
the reference values were to change (when cylinders are replaced). The system will store 
the most recently entered reference values for future calibrations. 
 

6.1.1.1 Connect the Portable Unit to the PC by the serial port. 
6.1.1.2 Open computer. 
6.1.1.3 Open K4 b2 software. 

6.1.1.4 Click “Test”  “Calibration” OR press . 
 
NOTE: A log file is automatically created. It logs a history of past calibrations conducted by 
the user. To access the log file, select “File”  “Report File…” from the calibration 
program. 

 
 

6.1.1.5 Click on “Calibration”  “Reference Values…” 
6.1.1.6 In the reference values box, type the correct values as follows, unless 

concentration of calibration gas changes: 
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6.1.1.7 Click “OK”.   
 

6.1.2 OPTION 2: Set reference values using the Portable Unit 
6.1.2.1 Using up/down arrows, select “Calibration”  “Enter”. 
6.1.2.2 Using up/down arrows, select “Set. Cal. Predicted Values”  “Enter” 
6.1.2.3 Type the values using the arrow keys: Cylinders (%x100): O2 = 1600, CO2 = 

500, O2 100% = 100; Environment (%x100): O2 = 2093, CO2 = 3  Syringe 
(ml) = 3000  “Enter” to confirm changes  “Cancel” to go back to main 
menu. 

 

6.2 Calibrating Flow and Volume 

6.2.1 Connect 3 Liter syringe to smaller components as shown below: 

 

Legend: 
1. Calibration syringe   
2. Silicone tube   
3. Calibration syringe adapter  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NOTE: If a bacterial filter is used for testing you should also include one during the 
turbine calibration.  

 
6.2.2 OPTION 1: Select appropriate turbine type using the PC software 

6.2.2.1 Click “Calibration”  “Turbine results…”  In “Turbine calibration results 
window under “Type (mm)” enter “28”. 

 
6.2.2.2 Click “Ok”. 

 
6.2.3 OPTION 2: Select appropriate turbine type using the Portable Unit. 

6.2.3.1 Using up/down arrow keys, select “Settings”  “Enter”. 
6.2.3.2 Using up/down arrow keys, select “Turbine 18/28”  Press “Enter”. 
6.2.3.3 Using up/down arrow keys, select “28”  “Enter”  “Cancel” to go back to 

main menu. 
 

6.2.4 OPTION 1: ID28 turbine calibration using PC software 
6.2.4.1 Select “Calibration” then “Turbine”. 
6.2.4.2 Make sure that calibration piston on 3 Liter syringe is pushed all the way in 

and sample line is connected to optoelectronic reader. 
6.2.4.3 In “Turbine Calibration” window, instructions to follow appear. Click “Ok”. 
6.2.4.4 When “Calibration” dialogue box appears, move piston out and in for 10 

strokes.  
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6.2.4.5 In the “Turbine calibration results” window, the new calibration factors and 

the acceptability ranges will be displayed. 

 
6.2.4.6 Click “OK”. 

 
6.2.5 OPTION 2: ID28 turbine calibration using the Portable Unit 

6.2.5.1 Connect sampling line to portable unit in inlet called “Sampling” and 
optoelectronic reader.  

6.2.5.2 Connect optoelectronic wire (black) to portable unit in inlet called 
“Turbine”.  

6.2.5.3 Using up/down arrows, select “Calibration”  “Enter”. 
6.2.5.4 Select “Turbine Calibration”  “Enter”. 
6.2.5.5 Move the syringe until message “Operate syringe” disappears. Display will 

show expired (E) and inspired (I) readings for each stroke.  

 
6.2.5.6 When display reads “Calibration Done” the new calibration factor has been 

stored. 
6.2.5.7 Press “Cancel” twice to return to main menu. 
6.2.5.8 Remove optoelectronic reader and syringe adapter from 3L syringe and 

separate both pieces. 
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6.3 Room Air Calibration – Before Every Test 

6.3.1 OPTION 1: Room air calibration using PC software 
6.3.1.1 Remove optoelectronic reader from 3L syringe and syringe adapter. 
6.3.1.2 Remove sampling line from optoelectronic reader leaving sampling line 

attached to portable unit. 
6.3.1.3 From “Calibration” menu, select “Room Air”. 
6.3.1.4 The message “Room air calibration in progress…” will appear and a graph 

will show in real time O2 and CO2 calibration. At end of calibration, message 
“Calibration done” will appear. 

6.3.1.5 The “Analyzers Calibration Results” window will appear. 

 
6.3.1.6 Click “OK”. 

 
6.3.2 OPTION 2: Room Air Calibration using Portable Unit. 

 
NOTE: Room air calibration performed is small rooms (high concentration of CO2) 
affects the calibration results and the accuracy of the following tests. 
 
NOTE: Be sure to put the sampling line far away from expired gas otherwise 
calibration could be affected. 
 
6.3.2.1 Using up/down arrows, select “Calibration”  “Enter”  “Room Air 

Calibration”  “Enter”. Screen will display the following: 
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6.3.2.2 Procedure is automatically performed until message “Calibration done” 
appears. O2 and CO2 values will be displayed on screen as such: 

 
6.3.2.3 Press “Cancel” to exit calibration menu. 

 

6.4 Reference Gas Calibration 

6.4.1 OPTION 1: Reference gas calibration using PC software. 
6.4.1.1 Connect high-pressure tube on gas tank to the “300-500 Kpa” inlet on 

calibration unit. 

 
6.4.1.2 Make sure that the secondary leak valve on the high-pressure tube is off (i.e. 

perpendicular to line). 
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6.4.1.3 Open gas tank by turning main valve counter-clockwise. Open primary leak 

valve. Set the pressure value within the range of 300-500 Kpa (3-5 bars or 
44-73 psi). 

6.4.1.4 Connect Portable Unit to PC by serial port. Remove sampling line from the 
optoelectronic reader. 

 
6.4.1.5 Change the secondary leak valve on high-pressure tube to on (i.e. parallel to 

line). 
6.4.1.6 Run calibration program. Click on “Calibration”  “Gas”. 
6.4.1.7 In “Gas Calibration” window, instructions to follow appear. Click “Ok”. 
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6.4.1.8 The message “Reference Gas calibration in progress…” will appear. When 

“Sample reference gas…” appears, plug in sampling line into “Sampling” inlet 
on calibration unit. 

 
6.4.1.9 The message “Calibration done” will appear.  
6.4.1.10 Click “Ok”. 
6.4.1.11 Change the secondary leak valve on high-pressure tube to off (i.e. 

perpendicular to line). 
6.4.1.12 Remove sampling line and close gas tank by turning valve clockwise. 
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6.4.2 OPTION 2: Reference gas calibration using Portable Unit. 
6.4.2.1 Connect high-pressure tube on gas tank to the “300-500 Kpa” inlet on the 

calibration unit. 

 
6.4.2.2 Make sure that the secondary leak valve on the high-pressure tube is off (i.e. 

perpendicular to line). 
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6.4.2.3 Open gas tank by turning main valve counter-clockwise. Open primary leak 

valve. Set the pressure value within the range of 300-500 Kpa (3-5 bars or 
44-73 psi). 

6.4.2.4 Make sure sampling line is not connected to “Sampling” inlet on calibration 
unit. 

 
6.4.2.5 Open secondary leak valve on high-pressure tube. 
6.4.2.6 Click “Calibration”  “Enter”  “Reference gas calibration”  “Enter”.  
6.4.2.7 When message “Sample reference gas…” appears connect sampling line to 

“Sampling” inlet on calibration unit. 
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6.4.2.8 The message “Calibration done” will appear.  

 
 

6.4.2.9 Press “Enter” or “Cancel”. 
6.4.2.10 Change the secondary leak valve on high-pressure tube to off (i.e. 

perpendicular to line). 

 
6.4.2.11 Remove sampling line and close gas tank by turning valve clockwise. 
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6.5 Gas Delay Calibration - Performed each week or when change occurs to 
sampling system (i.e. when sampling line is changed) 

6.5.1 OPTION 1: Gas delay calibration using PC software  
6.5.1.1 Connect Portable Unit to PC by serial port. Remove sampling plug from the 

optoelectronic reader. 
6.5.1.2 Click “Calibration”  “Delay” 
6.5.1.3 In “Delay Calibration” window, instructions to follow appear. Click “Ok”. 
6.5.1.4 The message "Gas calibration in progress..." will appear. At the end of the 

Room Air calibration the following message appears:

 
6.5.1.5 Click “Ok” to start breathing at a constant rate. 
6.5.1.6 Synchronise the breath (inspiration and expiration) with acoustic signal. 
6.5.1.7 Continue breathing until message “Calibration Done…” appears. 
6.5.1.8 When dialogue box opens, illustrating new calibration factors click “Ok”. 

6.5.2 OPTION 2: Gas delay calibration using portable unit 
6.5.2.1  On main menu, select “Calibration”  “Enter” “O2/CO2 delay 

calibration”  “Enter”. 
6.5.2.2 A room air calibration will be performed with the following message 

appearing: 
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6.5.2.3 When message “Connect the sampling line and press enter” appears, press 
“Enter” and start breathing at a constant rate. Synchronize the breath 
(inspiration and expiration) with the acoustic signal. 

6.5.2.4 When dialogue box illustrates new calibration factors click “Cancel”. 
 

6.6 Previewing Calibration Report 

6.6.1 Click “File”  “Preview”. 

 
6.6.2 Choose desired report visualization (numerical values or graphs) by selecting the 

relative option in the lower part of the dialogue box. Values in blue indicate that the 
values are equal to their predicted value. Values in red represent a result that 
occurred outside of the acceptable range. 

6.6.3 Click “File”  “Print”. 

 
 

7. Installation of K4 b2 on Participant 
7.1 Installation of HR transmitter 

7.1.1 Wet sensors of HR transmitter.  
7.1.2 Place HR transmitter on thorax of participant under breast line directly on 

the skin. Strap should be tight and comfortable. Adjust strap if necessary. 
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7.2 ECG Preparation and Placement (if required) 

7.2.1 Ask participant to remove jewelry (i.e. necklace) and watch, if any. 

7.2.2 Wearing gloves, shave hair from electrode sites, if necessary.  

NOTE: For females, place the precordial electrodes on top of the breast (not over the breast 
tissue). 

7.2.3 Cleanse area with alcohol swab. 

7.2.4 Using abrasive ECG prep tape, lightly scratch an “X” pattern into the skin, 
taking care to avoid excess abrading. 

7.2.5 Dry the skin vigorously with a gauze pad. 

7.2.6 Attach the electrodes to the lead wires before attaching them to participant. 

7.2.7 Place electrodes as instructed by the manufacturer. Press the contour of 
electrode. Avoid pressing the center of the gel area. 
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7.3 Installation of Harness 

7.3.1 Place harness on participant. 
7.3.2 Place K4 b2 Unit on the front of the harness and a battery pack on the back. 
7.3.3 Connect the battery cable to the 6V plug of the K4 b2 control panel. Be sure 

that the red plug, that protects the plug from water or sweat drops, is on the 
Portable Unit side. 

7.3.4 Connect the antenna plug to the “Antenna” plug of the Portable Unit control 
panel and to the side of the antenna on the battery. 

7.3.5 Connect the antenna to the top of the battery. 
7.3.6 Insert the heart receiver and temperature probe cable in the “HR-Temp” plug 

placed on the control panel. 
7.3.7 Insert the male connector of the turbine in the Turbine plug on the control 

panel. 
7.3.8 Fix the power supply cables, antenna and turbine on the right side of the 

harness with the Velcro straps. Fix the heart frequency probe on the left side. 
 

NOTE: Be sure to position the HR probe on the left side, while the other cables have 
to be fixed on the right side. This must be done to avoid interferences between cables. 
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7.4 Installation of Mask 

7.4.1 Fix the mask as illustrated in the picture below. Adjust the elastic bands on the head 
cap as necessary to eliminate possible leaks and create a tight seal around the 
subject’s face. 
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7.4.2 Ask participant to lightly seal hole with palm of hand to check for any mask leaks. If 

pressed too hard, mask will deform thereby creating leaks. 
 

8. Spirometry 
8.1 Patient Preparation 

8.1.1 Disconnect the sampling line from the flowmeter.  
8.1.2 Calibrate the turbine as indicated in the Calibration portion of this POD. 
8.1.3 Attach flowmeter to the handle. 
8.1.4 Put on antibacterial filter. 
8.1.5 Explain the manoeuvre to the participant: “Breathe normally, then perform a 

maximum inspiration followed by a maximum forced exhalation”. Make sure 
that participant is sitting with both feet on the floor, back on the chair.  

8.1.6 Instruct participant to apply nose clip.  
 

8.2 Performing a Forced Vital Capacity (FVC) Test  

8.2.1 In the menu, select “Test” → “Start” → “Forced Vital Capacity” or press “Test” 
icon → “Forced Vital Capacity pre” and wait until the green LED appears on the 
right side of the screen.  

 
NOTE: To utilize the patient encouragement function, select “View” → “Encouragement” 
prior to executing the test. The dotted bubble represents the predicted value, and the blue 
bubble represents the actual value.  
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8.2.2 When ready press F2 or the “Start” icon to execute the test.  
8.2.3 When completed press F3, the “Stop” icon, or wait for the automatic end (5 

seconds without flow).  
8.2.4 To abort the test press Alt+F3 or the “Abort” icon.  
8.2.5 To restart the test, press the “Redo” icon.  
8.2.6 To visualize the Flow-Volume graph, Volume-Time graph, or the main 

parameters click on one of the following:  

  
8.2.7 Repeat the test until the desired number of manoeuvres has been obtained 

correctly.  

8.2.8 Press  to visualize the test list carried out during the current session. 
8.2.9 Select the test you wish to save (results are sorted from best to worst 

according to AATS criteria). 
8.2.10 Press “OK”. 
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8.3 Performing a Slow Vital Capacity (SVC) test  

8.3.1 Select “Test” → “Start” → “Slow Vital Capacity” or press “Test” icon → “Slow 
Vital Capacity” and wait for the green LED to appear on the right side of the 
screen.  

8.3.2 Explain the manoeuvre to the participant: “Breathe normally, then perform a 
maximal inspiration followed by a slow maximal exhalation”. Make sure that 
participant is sitting with both feet on the floor, back on the chair. 

8.3.3 Instruct participant to apply nose clip.   
8.3.4 Press F2 or the “Start” icon to begin the test and follow the prompts on the 

monitor.  
8.3.5 When completed press F3, or the “Stop” icon, or wait for the automatic end (5 

seconds without flow).  
8.3.6 To visualize the Flow-Volume graph, the Volume-Time graph, or the main 

parameters click on one of the following:  

 
8.3.7 Repeat the test until the desired number of manoeuvres has been obtained 

correctly.  

8.3.8 Press  to visualize the test list carried out during the current session. 
8.3.9 Select the test you wish to save (results are sorted from best to worst 

according to American Thoracic Society (ATS) criteria). 
8.3.10 Press “OK”. 

8.4 Performing a Maximal Voluntary Ventilation (MVV) Test  

8.4.1 Select “Test” → “Start” → “Maximum Voluntary Ventilation”, or press the 
“Test” icon → “Maximum Voluntary Ventilation” and wait until the green LED 
appears on the right side of the screen. 

8.4.2 Explain the manoeuvre to the participant: “breathe as deep and fast as possible 
for 12 seconds”. Make sure that participant is sitting with both feet on the floor, 
back on the chair. 

8.4.3 Instruct participant to apply nose clip. 
8.4.4 When the patient is ready instruct them to begin and press the F2 key or the 

“Start” icon.  
8.4.5 When the effort is completed, press F3, or the “Stop” icon, or wait for the 

automatic end of the test (after 5 seconds without flow).  
8.4.6 To abort the test, press Alt+F3 or the “abort” icon. 
8.4.7 To restart the test, press the “Redo” icon. 
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8.4.8 To visualize the Flow-Volume graph, the Volume-Time graph, or the main 
parameters click on one of the following: 

  
8.4.9 Repeat the test until the desired number of manoeuvres has been obtained 

correctly.  

8.4.10 Press  to visualize the test list carried out during the current session. 
8.4.11 Select the test you wish to save (results are sorted from best to worst 

according to AATS criteria). 
8.4.12 Press “OK”. 

 

8.5 Viewing Test Results  

8.5.1 Press File → Patients or press the icon. 
8.5.2 Select the patient whose test you would like to view. 
8.5.3 Select up to 5 tests to view from the test list box (FVC, VC/IVC, or MVV). 

Press “OK”.  
8.5.4 To switch between graph and/or data visualization use the following buttons: 

 
8.5.5 To visualize more than one window at a time, select “Window” → “New 

Window”.  
8.5.6 To display the list of tests of the current participant select “View” → “Test 

current patient”, or press the  icon.  
8.5.7 To display a trend of more than one test performed by the same patient select 

“View” → “Trend”.  
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8.5.8 Select the tests and graphing options you want to display. 
8.5.9 Press “OK” to confirm.  

 

9. Conducting an Exercise Test 
9.1 OPTION A - Holter Data Recorder Mode – used when a participant difficult 

to monitor by telemetry (i.e., climbing, long distance races, etc.). 

This option allows for the system to be used without the Receiver Unit. Up to 1 MB (16 
thousand breaths) of breath-by-breath data is stored within the Portable Unit. Results 
can be downloaded to the PC via the RS 232 port.  
 

9.1.1 Equipment required 
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1. Mask, flowmeter, and optoelectronic meter 
2. Heart rate transmitter 
3. Rechargeable battery  
4. Harness 
5. Portable unit 
6. HR probe 
7. Power cable 

 
9.1.2 Set up K4 b2 on participant 
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9.1.3 Enter new participant 
9.1.3.1 From “Test” menu, select “Patient’s data”. 
9.1.3.2 Move the cursor among fields with the Enter key and use Up and Down 

arrow keys to modify values. 

 
# = patient ID 
A = age in years 
H = height (cm or inches) 
W = weight (kg or lbs) 
S = sex (M or F) 
HR = HR max (automatically calculated using the formula 220-age) 
 

9.1.4 Remove sampling line from the mask and do not breath close to it. 
9.1.5 On “Patient Data” menu, scroll down and select “Start Test”. Press “Enter” to 

confirm. 
9.1.6 The message “Insert relative humidity” will be visualized, type the correct value 

and press “Enter”.  

 
 

9.1.7 A Room Air Calibration will automatically start. The message “Do not breath 
near the sampling line” appears. Wait a few seconds until the message 
“Calibration done” will appear with a double beep sound. 

 
 

9.1.8 Connect the sampling line to the optoelectronic reader. Some values (HR, R, 
VO2, VCO2, …) will be shown and updated each breath on the control panel 
display. The message “Press enter to start the test” will be displayed every 10 
seconds. You can switch to different values by moving the Up and Down arrow 
keys. 

9.1.9 Press “Enter”. At this time the Portable Unit is not storing data but checking the 
main parameters and you can visualize it on the Portable Unit display as “Time” 
will be blinking. 
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9.1.10 Press “Enter” to start storing data. 

 
 

9.1.11 To stop the test, press “Cancel”. The message “Press Enter to stop test” will 
appear. Press “Enter” to stop test. 
 

9.1.12 Transfer test to PC 
9.1.12.1 Turn Portable Unit on is not already. 
9.1.12.2 Connect Portable Unit to PC by the serial cable and open K4 b2 

software. 
9.1.12.3 Click “Test”  “Receive Test”. 

 
 

9.1.12.4 To download a test, click “Find”  “List” to select an existing 
participant.  “OK”. 

9.1.12.5 Use “First”, “Previous”, “Next”, and “Last” buttons to select a test on 
the Hard Disk  click “Download”.  

 
NOTE: The “Preview” button can be used to view data and graph a test in order to 
verify whether it is the correct test. 
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9.2 OPTION B - Telemetry Data Transmission Mode – used to monitor test in 
real time from a distance. 

This option allows for the system to be used with the Receiver Unit where breath-by-
breath data is sent by telemetry to the Receiver Unit. The Receiver Unit must be 
connected to the PC by serial port. Tests are also stored in the memory of the Portable 
Unit, thus in case of transmission interferences no data will be lost. By using this option 
the individual can also control and synchronize ergometers by using user defined 
exercise protocols. 
 

9.2.1 Equipment required 

 
 

1. Mask, flowmeter, and optoelectronic reader 
2. Heart rate transmitter 
3. Rechargeable battery and antenna 
4. Harness 
5. Portable Unit 
6. HR probe 
7. Power cable and antenna 
8. Receiver Unit 
9. RS232 cable 
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10. PC 
 

9.2.2 Connect the receiver unit to the PC with serial cable. 
9.2.3 Turn Receiver Unit on. 

 
NOTE: The Receiver Unit must always be turned on before the Portable Unit. 

 
9.2.4 On Portable Unit control panel, verify that transmission is enabled by choosing 

“Settings/On/Off Transmitter”. Press “Enter”. Move “*” sign on “Transmit On”. 
Press “Enter”. 

9.2.5 Enter new participant 
9.2.5.1 From “Test” menu, select “Patient’s data”. 
9.2.5.2 Move the cursor among fields with the Enter key and use Up and Down 

arrow keys to modify values. 

 
# = patient ID 
A = age in years 
H = height (cm or inches) 
W = weight (kg or lbs) 
S = sex (M or F) 
HR = HR max (automatically calculated using the formula 220-age) 

9.2.6 Enable reception on PC  
9.2.6.1 Run software 
9.2.6.2 Open participant dialogue box, select or type a new name and press 

“Ok”. 
9.2.7 Remove sampling line from the mask and do not breath close to it. 
9.2.8 On “Patient Data” menu, scroll down and select “Start Test”. Press “Enter” to 

confirm. 
9.2.9 The message “Insert relative humidity” will be visualized, type the correct value 

and press “Enter”.  

 
 

9.2.10 A Room Air Calibration will automatically start. The message “Do not breath 
near the sampling line” appears. Wait a few seconds until the message 
“Calibration done” will appear with a double beep sound. 
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9.2.11 Connect the sampling line to the optoelectronic reader. Some values (HR, R, 
VO2, VCO2, …) will be shown and updated each breath on the control panel 
display. The message “Press enter to start the test” will be displayed each 10 
secs. You can switch to different values by moving the Up and Down arrow 
keys. 

9.2.12 Press “Enter”. At this time the Portable Unit is not storing data but checking the 
main parameters and you can visualize it on the Portable Unit display as “Time” 
will be blinking. 

 
 

9.2.13 Press “Enter” to start storing data. 

 
 

9.2.14 To stop the test, press “Cancel”. The message “Press Enter to stop test” will 
appear. Press “Enter” to stop test. 
 

9.2.15 Transferring test to PC 

NOTE: If some interferences should occur during the test execution by 
telemetry, some breaths could be lost. The software shows a message on the 
status bar warning that some steps were missed. Since the Portable Unit stores 
the complete test in the memory, it is possible to download the test after 
completion to recover all lost data. 
 

9.2.15.1 Turn Portable Unit on is not already. 
9.2.15.2 Connect Portable Unit to PC by the serial cable and open K4 b2 

software. 
9.2.15.3 Click “Test”  “Receive Test”. 
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9.2.15.4 To download a test, click “Find”  “List” to select an existing 
participant.  “OK”. 

9.2.15.5 Use “First”, “Previous”, “Next”, and “Last” buttons to select a test on 
the Hard Disk  click “Download”.  

 
NOTE: The “Preview” button can be used to view data and graph a test in order to 
verify whether it is the correct test. 

 

9.3 OPTION C - Serial Mode – used like a conventional laboratory station (i.e. 
software completely controls the unit). 

Although the Cosmed K4 b2 has been designed for field tests, it can also be used as a 
conventional laboratory station as it offers the same features as standalone devices. For 
this option, the Portable Unit needs to be connected to the PC through the RS232 
serial port. Data is also stored on the memory of the portable unit. 
 

9.3.1 Equipment required 
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1. Mask, flowmeter, and optoelectronic reader 
2. Heart rate transmitter 
3. Rechargeable battery 
4. Harness 
5. Portable Unit  
6. HR probe 
7. Power cable 
8. Receiver Unit 
9. RS232 cable 
10. PC 

 
9.3.2 Connect the receiver unit to the PC with serial cable. 
9.3.3 Click “Option”  select “RS232” to select serial port. 
9.3.4 Check the box “Ergometer connected to PC” if you intend to use an ergometer 

for testing. 
9.3.5 Enter participant data 

9.3.5.1 Run software 
9.3.5.2 Open participant dialogue box, select or type a new name and press 

“Ok”. 
9.3.6  Start test. 
9.3.7 Select the participant. 
9.3.8 Enter patient data 
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9.3.9 Start the test. 
9.3.10 To stop test, click “F3”  “Ok” 

 
NOTE: All data will be saved automatically on the Hard Disk and on Portable Unit. 

 

10. GPS (Optional) 
 
NOTE: The GPS can only be used in Holter Recorder Data Mode (OPTION A above) 
or Telemetry Data Transmission Mode (OPTION B above). 
 

10.1 Initialize the GPS 

10.1.1 If the receiver has not been used for a period of 6 months or more, the unit will 
search the sky in order to collect satellite orbital information. This process is 
fully automatic and, under normal circumstances, will take 3-4 minutes to 
achieve a navigation solution. 

10.1.2 If the memory backup battery of the GPS fails, the receiver will search the sky 
as described above. Should the memory battery discharge, the unit needs to be 
powered on for several hours to ensure a sufficient recharge to maintain several 
months of clock operation and memory storage. 

10.1.3 If the initial data is significantly  inaccurate, the receiver will perform an 
operation known as AutoLocateTM. This will occur automatically and, under 
normal circumstance, will require 1.5 minutes to calculate a navigation solution. 

 
NOTE: the AutoLocateTM function can be manually forced by selecting 
“Calibration”  “GPS AutoLocate”. 

 
10.1.4 During the acquisition process a message “acquiring satellites…” is prompted 

on the display of the Portable Unit. 
 

10.2 Fixing the antenna to the participant 

10.2.1 Position GPS as shown below. For cycling or rowing, it may be required to 
position the antenna differently.  
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10.2.2 Connect the receiver antenna to the Portable Unit and plug the phone jack into 
the RS232 port at the bottom of the Portable Unit. 

 
 

10.3 Run a test with the GPS 

10.3.1 Select “Settings”  “External Device”  “Enter” 
10.3.2 To enable GPS option, move “*” sign on GPS  “Enter” 
10.3.3 Go outside and find a large open area that has a clear view of the sky. The GPS 

needs to receive at least three strong satellite signals to find your location.  
10.3.4 To check GPS module functionality, click “Calibration”  “GPS Control”  

“Enter” 
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10.3.5 Using Up and Down arrows verify that the displayed altitude value (Alt) is 
different from zero. If altitude value is zero, check to see if antenna receiver is 
well plugged in, the sky is visible and wait until the altitude value is shown. 

 
 

10.3.6 To monitor GPS in real time, in PC software select “Options”  “Parameters 
to view/Test execution …” or “ (real time) Parameters to view/Test 
visualization” (after download) 

10.3.7 The following parameters can be viewed: 
• Velocity – GPS Vel (m/sec) 
• Distance – GPS Dist (meters, incremented during exercise phases 

only) 
• Latitude – Lat (DD MM.MMM’N/S) 
• Longitude – Long (DD MM.MMM’E/W) 
• Altitude – Alt (meters) 

NOTE: Distance is automatically calculated for the exercise phase only. 
 

 
 

11. Cleaning and Disinfecting  
11.1 ID28 Turbine 

NOTE: The Turbine needs to be cleaned and disinfected after each test. 
 
NOTE: Do not use alcoholic solutions to clean Turbine as it can damage the plastic 
material. 
 

11.1.1 Take out the turbine. 
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11.1.2 Prepare one of the following solutions: 
• For use within 24 hours - 1 part household bleach (sodium 

hypochlorite 5.25%) to 9 parts water. 
• For use within 30 days - 1 part household bleach (sodium 

hypochlorite 5.25%) to 4 parts water. 
11.1.3 Soak Turbine in solution for 20 minutes. 
11.1.4 Rinse the Turbine in a vessel filled with clean water, shaking gently to remove 

the disinfectant. 

NOTE: DO NOT RINSE BY PUTTING UNDER RUNNING WATER! 
 

11.1.5 Check if the turbine propeller rotates freely even with a low speed airflow. 
11.1.6 Let air dry. 

 

11.2 Facemasks 

NOTE: Facemasks need to be cleaned and disinfected after each test. 
 
11.2.1 Prepare a solution of hot water and mild detergent. 
11.2.2 Place facemask(s) in solution. 
11.2.3 Rub vigorously in soapy water. 
11.2.4 Rinse facemask vigorously in warm water. 

 

11.3 Sampling Line 

11.3.1 No cleaning or disinfection required. Let air dry. Alternate use of sampling lines 
between participants. 

 

11.4 Antibacterial Filters 
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11.4.1 No cleaning or disinfection required. Disposable after each use. 
 

11.5 Tubing for Aquatrainer 

11.5.1 Remove clear tubing from Aquatrainer by slowly sliding out of various loops and 
yellow plastic structures wrapped around tubing.  

11.5.2 Prepare a solution with warm water and mild soap.  
11.5.3 Place tubing in solution making sure that solution is found within the tubing. 

Shift tube up and down to allow water to displace. 
11.5.4 Let air dry.  
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Portable Unit User Interface 
Diagram 
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Portable Unit User Interface Diagram 
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APPENDIX 2 

Toolbar Icons 
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APPENDIX 3 

POD Training Record Form 
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Use and Cleaning Procedures for Cosmed K4 b2 Portable Metabolic System 
 
POD Code 
  

Ownership Document 
type Area POD Number Version 

PC POD CP 009 01 
 
 
 
Training Record 
 

Full Name  

Institution  

Contact  
(email or phone number)  

 
 
Signature 
 
 
   

Sign here (trainee)  Date 
 
 
   

Sign here (Cardio-Pulmonary Coordinator)  Date 
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